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IPT Correlations Chart

Good Morning ESOL Contacts,

What?

The IPT Correlations Chart has been updated. All previous versions (2010 and 2017) must be discarded.

» You must use the 2018 IPT Correlations chart in order to identify your ELLs.
« The 2010 version of the |PT booklet can be used along with the 2018 Correlations chart.

Why?

The IPT was renormed and as a result the Broward County 2018 Correlations Chart was updated.

Stawrting when?:

Effective immediately. Monday, August 27, 2018
« You must use the 2018 IPT Correlations chart in order to identify your ELLs.

Where do-I find information?

Attached you will find the following:

« 2018 Correlations Chart
« |IPT | Oral Designation chart K-35 (2017)
« IPT Il Oral Designation chart 6-12 {2017)

This information is also available via the Bilingual/ESOL SharePoint and Canvas Course.

Bilingual/E50L SharePoint link:
hitps:fbrowardcountyschools. sharepoint. comisites/esolprogram/SitePages/Home. aspx

ESOL Contacts Canvas course link:
hittps://browardschools.instructure. com/courses/598658
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Extension of Services
in ESOL Programs

Must have an ELL Committee to extend services

Convened no earlier than 30 school days prior to the third
anniversary of the student’s Date Entered United States School
(not ELL: Entry Date)

Cannot be after the anniversary date

If the anniversary date falls between the release of the statewide
assessment results and October 1 of the following school year,
districts may use them to satisfy the assessment requirement in
the rule as part of the discussion to extend services so the ELLs
will not have to be tested again.

This does not mean that districts have until October 1 to convene
the ELL Committee unless the students have anniversary dates in
the first two weeks of school.
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o Let's take a closer Look....
O Extension of Services (REEVAL)Rule

Student date: | Assessment Datato | ELL Committee
Review at ELL Meeting
Committee Meeting Required

8/ 15 - 8/29 FSA/ACCESS Until October 1

On or 30 days
8/30-9/30 FSA/ACCESS prior to DEUSS
date

10/1 and beyond Full battery of IPT On or 30 days
(Listening/Speaking/  prior o DEUSS
Reading/Writing) date




@ELL Committee Meetings

Two of the state approved criteria must
be substantiated in the Student Meeting Report as well as
notes with specific goals in ELLevation to document and
support recommendation for exiting or continuing in the

ESOL Program.

Notes:
Student will increase the overall

ACCESS 2.0 score by .5 and FSA
ELA by one level. Contfinued
Accommodations are required.

What specific
goal can be
written for this
student?
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New Saving ELL Plans

ESOL Contacts are now able to generate and save ELL Plans electronically to Student Profiles!

Why?

During the 2015-16 FTE Audit, some of our schools were cited for not having hard copies of ELL plans filed
in ELL Folders. We have been working diligently with ELLevation to find a solution. We are excited to
announce the launch of the ELL Student Plan feature on Ellevation!

When?
Effective immediately, it is required to both SAVE the electronic copy within Ellevation and Print the
ELL Plans to file in the ELL folder.

How?
Attached are the written directions for your reference. We encourage you to watch this short clip on how
to SAVE ELL Plans in each child's Documents Folder: https://soapbox.wistia.com/videos/ly06hVHEYE

If you have any additional questions, please contact us at (754) 321-2590 or your assigned Instructional
Facilitator.

. _ Directions are found on Canvas. Under the
Stephanie Bustillo

Educational Specialist ESOL Handbook Tab, select:

600 SE 3rd Avenue
Fort Lauderdale, FL 33301
P: 754-321-2573 F: 754-321-2598 i 2 TT*NEW™Saving ELL Plans Electronically.pdf




ELL Plans
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Saved ELL Plans
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https://login.ellevationeducation.com/

Downidoac FO@®] Sawe Nykase

Frimt

Student &
IDate:
Thime:

ELL Plan

SriafzmlE Browand County Public Schoobs

1-48H PM

Student Information

Student: Test ID &: Student #:
Gender: Date of Birth: schaol:
Hispanic/ Latino:
Phoney Cell Address: Teachear:
: Grade Lewel:
EL'::"‘““"" Birth Country:
M age: Imirmigrant: Homealess:
Active: Homebound: Migrant:
TEF: Mo S Bilingual:
Dual
Language:

Re-Ewal Date: 9/ L2/ 20 1E
Bacis of Entry: A-sural/Oral

Lang. Classification: =
Zmd Date Exited

ELF Designaticn: ELL ESOL Status: LY (ELL Current) Tiar:

Receiving ESOL Swcs: Yos

ZOA1B/2019 - Year
Service #F1: C - MainstreamyInclusion - Core/Basic Subject Arcas
ZOA7F /2018 - Year
Serwvice =1 Title LI - Tutoring 3= ) Wiesk [D:a5])
Service ¥2: C - Mainstreamy Incesicn - Core/Basic Subject Areas Sx f Wieak [as needed)

Toacher/Prowvider Schoeduls

Tx S T (as meeded]

Program 130

ZOAESE0LTF - Year

Service #1: C - Mainsfreamy Inclusion

- Core/Basic Subject freas

1= f Day (a5 necded])
ZOAS/ E0LE - Year
Service #F1: C - MainstreamyInclusion - Core/Basic Subject Arcas

Accommodation
 Plan date
Test scores

Clamsroam Teacher 1w f Day (25 meoeded)
LP [Fending Proficiency):
Program Participation:
Basis of Entry: &-fural/Cral
Basis of Exit (First): Z-hNat avaisbie
Basis of Exit [ Seocond ) :
Title IIL/ Immigrant Sar.:
Other EXxceptionality:
Lang. Clascification: 4
Diiplema Description: MNAa
Znd Date Exited ESOL:

should be updated
before printing

Father:
Miother:

WWork:
W ork:
Home Language: Soanish

Interpreting® Mo
Interpreting? Mo

He -5 L&D

Camie imto US:

Date Entered US Schools: B/ 1S/2013
District Encrocliman B1ey2013

ESOL Program Emtry Date: B/15/2013
ExiIt Date 1

Home Language Survey Datbe
Parent Demndal Date:
=sification Date

Re-Eval Date:

Fears in US School: &

Graduated:

Wt A

Dropped Duk:

Monitored Sinoe:
Monitoring Statwus: Mot Maon@ored

Farent Granted Permiscion Date:
ELL Flam Date
Re-Class Date:

BS2/2013

31252018

F1zfa0LE

Graduated: Mo

S504: No

Exwtended Instruction > 3 Years: No
Gifted and Talonted: No

W ithdrawmn: Mo
SIFE: Mo
Pre-aFfaf: No

Dropped Out: Mo Deceased: Mo

ELL Flan Owt of Date: No

Special Educatian:

Chronoloay

Start Ston Activity Start Stop Activity
L. 4/13/2008 10 Years, 5 months 13. I/BESZD1E ACCESS for ELLs 2.0, 2-3, Gro: 2
2. B/BESZDLE IFT Grd: K 13, BYLS2D16 S/ALBO0LT  Accommmodations/Ewemptions wsed ALL
=T BfleyI0L3 ES0L Program Entry Date State and District Assessments
4. B/L9sZOL3 Ceate Entered US Schoals IS, SY2L/PO0LE SWZL/POLS  Meesting: 4th Yesr Reevalustion
= B/lEyZ0LE Enroiled m Browand County L&. L/30/20L7 ACCESS for ELLs 2.0, 2-3, Gro: 3
B. /L2014 CELLA, K-2, Grd:z & L7, BY1S2017 S/3LB018  Accomamodations/Ewemptions wsed ALL
7. 4/l 2014 IPT Grd= B State and District Assessments
) y b N By oaE s R -
B, BSLSfZD14 5/31/2015 Accommodations/Exemptions used L - S2E2OLT W2ZH/ZOLT  Mesting: Sth Year Recvaluation
State and DiSITIct Asoessments = et -
9. 2/l 2015 CELLA, -2, GErds 1 0. SfAL3019 Accommodations/Ewemptions wsed ALL
10, a/las2aLs IPT Grd= 1 State and District Assessments
3 1/ 1 3 .
Ll. BFL/2D1S =0 & =2 B Accommaodations/Exemptions wsed sl | 21 ELL Flan Date
State and DiSITIct Asoessments 2. Re-Eval Date
L2 Sf15/201S Y15/ BOLS Mesting: 3rd Year snnuoal Evaluation 3. Sr12/3018 FMecting : Bth Yeor Rocwvalustion




When are ELL Plans generated?

« At the beginning of the
school year for all LY
students.

« Anytime there is an ELL
Committee Meeting

« Or any time there is a
Change in Program
Services

« After students have met . . .
exit criteria and exited on Please wait until all data is

TERMS updated and accurate on
TERMS before generating,
filing and saving ELL Plans.




Shared View

An Ellevation view has been shared with you

Today, 1543 AM

e Ellevation Education <noreply@ellevationeducation.com=>
Stephaniz M. Bustilo ¥

I To help protect your privacy. some content in this meszage has been blocked. To 're-2nabis the blockad features: dick heg

I To abways show content from this zender, dick here.

An Ellevstion view has been shared with yo

[#Enevation

Celina Chavez has creaied and shared a new student list view with you.

You can access this view by clicking the link below. You can also access this and any
other viewss by visifing the "Shared With Me" menu on the student list.

hitps:ifapp.ellevalioneducation.com/Students/List ?viewl D=80932

Thanks,
The Ellevation Team

Having trouble logging in? k here o reset yowr passvwend.

© Ellevatien Education | All Rights Reserved.
#fellevationeducation.comlegal-notices#EllevationPrivacyPolicy]Privacy Policy |
N ellevationeducation. comflegal-notices#E levation TermsArdConditions[Terms and Conditions

Gatting too much email from Ellevation Education «noreply @ellevationaducation.com= 7 You can unsubscrite

]

£ Replyall | v




New Student List-Views

Sth grade Composite score Chart

My Saved Views

Active LY Students
Students who re Active LY Students in the ESOL Pro...

Shared With Me

Immigrant Students View
Students who are potentially Immigrant.

=

LF View - Active Students
LF Report of students who exited based on the 2017...

LF View Inactive Students
LF Report of students who exited based on the 2017...




Reminders




Tier Placement

TIER 2017-18 ACCESS Date Entered U.S
PLACEMENT FOR ELLs 2.0 School
(TERMS A23 Overall (DEUSS)

PANEL) Proficiency
Scores
A 1.0-2.0 07/01/2018 or after
B 2.1-3.0 Between 07/01/2016
and 06/30/18
C 3.1-6.0 Before 07/01/2016

TIER for Pre-K and KG = “Z”




Automated Exifing

(State Exit Criteria)

Exiting of Students: ETS will automate the exit process. (see page 4 for full document)
¢ For students who met exit criteria ETS will automate the following fi on
o Exit date & ELL Plan date (6/6/2018)
o ESOL Status (LF)
o Tier (Z)
e Alisting of students who qualify based on State Crit
the list and send home a Notification of Exit

LLevation. ESOL Contact must pull
ent Language (if applicable) and in English.

alified to exit via State Approved Exit
criteria. **

**This is only for stu

« ExpoWlist (view) for LF students

« Generate and print ELL Plan and file in the
ELL folder once ELLevation is up to date

« Generate and print a dated Parent Letter

— Notification of Program Exit




LF View(s)

My Saved Views

“Notification of Program Exit”
(Parent Letter) must be generated, filed and sent
home

"Shared Withite

Shared view(s) will facilitate this process

LF View - Active Students
LF Report of students who exited based on the 2017...

LF View Inactive Students
LF Report of students who exited based on the 2017...




Exit by ELL Committee Meeting

Requirements for EXITING English Language Learners from the ESOL

Program

These options are valid until October 1, 2018

Option | Grades K-2

Option | Grades 3-10

Option | Grades 10-12

ACCESS for ELLs 2.0, Enghsh inguage
prroficency level shall be 2 4.0 overall or
greater AND at keast 4.0 in the domain of
{Reading.

Pltermate ACCESS for ELLs proficiency devel
tshall be 2 P overall (compasie score) score
oF greater

ACCESS for ELL< 2.0, Enghsh language
proficiency level shall be 2 4.0 overall ar
greater AND at least 4.0 in the domaln of
Reading.

Akcrnate MCCESS for ELLs proficency level
shall be a P1 averall {compasite score) soore
ar greater

IAND

Passing scorc on the FSA m ELA (level 3) or
FSAA score

ACCESS for ELLs 2.0, Enghsh language
profiaency level shall be a 4.0 overall or
greater AND at least 4.0 in the domain of
Reading,

Alternate ACCESS for ELLs proficency level
shall be 3 P1 overall (composite score) soore
or greates

AND

Ome of the following graduation
requirements:

« Level 3 on the 10w grade FUAT (Reading)
o
&
« Leved 3 on 10= grade FSA in ELA or FSad
(Beading)
o
&
« A score of 18 an the ACT (Reading)
o
&
« A score of 480 on the SAT (Reading)

TERMS:

[Basts of Bxit: H & entered on o
o TERMS, Bt date 5 6

Basts of Exit: 15 entered on the A23 pancl
on TERMS, Exxt date 15 6/6/18

Basis of Bot: | & entered on the AZ3 pandd
oo TERMS, Exat date 15 6/6,/18

IPLAN Date 15 updated to match £XIT date

Date = updated to match EXIT date

PLAN Date s updated to match EXIT date

Option Il Girades K2

Option Hl Grades 3-10

Option Il Grades 10-12

Any student betng consderad for exit by an
ELL communtee shall mece at beast 2 of the
feritera blizhed m che ESOL dhook

Any student heng considered for ot by an
ELL committee shall mect at least 2 of the
oreeria hshed in the ESOL Handbook

pection & ELL Conymittos mecting nwast be
generated m ELLevabon.

ALCESS scores are valid umal 10/1/18

sectson 8 ELL Comnuctee mesting must be
pemerated in ELLevanon

MCCESS soones arc vabid untd 10/1/18

Any student being considered for exit by an
ELL commuttee shall mecs atleast 2 of the
eriteria established in the ESOL Handbook
pection 8 ELL Committes meeting nwast be
prnerated m ELLevabon.

ACCESS scores are valid umtil 10/1/18

For ESE/ELLs the comanittoe shall consider
fhe disahility and include the [EP Team

For /ELLs the commustec shall conssder
the disabdty and mdade the IEP Team,

For ESE/ELLs the commnittee shall consider
the disability and include the [EP Team.

[Bas1s of Bt for ELL convmttoe: L is
fenzered on the A23 pancl on TERMS. Boz
iate 15 the dace of the mecting

Bass of Bxat for ELL commuetes: Lis
entered om the AZS panel on TERMS. Bxit
date 15 the date of the mecting,

Bas1s of Bxit for ELL consmattee: Lis
pentered on the A23 panel on TERMS. Bat
iate is the date of the mecting.

PLAN Date 15 updated to match EXIT date

PLAN Date 2 updated to maech EXIT date

PLAN Date is updated to match EXIT date

NOTE: EXIT Notification better must he gencrated on ELLevation for all students exited from the ESOL program.

« A23 Panel: Update PLAN Date
and EXIT Date to the Meeting
Date

« Update Tier to “Z”

« Entfer Basis of Exit “L"

« ELL Status changes
automatically from LY to LF

ELLevation

« Generate and print ELL Plan
and file in the ELL folder once
ELLevation is up to date

« Generate and print Parent
Letter — Notification of Program
Exit

Section




Suggested IMT Forms

ESOL Contacts will provide IMT/IMS with the required data elements
throughout the school year. Based on feedback, forms have been created to
assist in communicating effectively to be in compliance!

"
vt BN R N Sy Pt B O 7

vvvvv

Note:

» Double check if the student attended another Broward school before testing.

» As asuggestion for Inter county transferring at the time of registration please attach the
AQ7 panel from TERMS to the form .

hitps://browardschools.instructure.com/




Instructional Models

Sheltered/Self-Contained Mainstreamed/Inclusion

» Students from different
language backgrounds
grouped to receive
instruction in content area

»Students in classroom with
non-ELLs

>»Teacher uses ESOL instructional

classes strategies

» Teachers adjust instruction »Can be effective when ELLs in
and the level of English used the same grade are grouped
to make content together with the same
comprehensible for students classroom teacher (clustering)

Getting Started with English Language Learners, Judie Haynes 2007

Dual Language

» Prepares students to become fully bilingual by learning listening, speaking, reading
and writing skills in English and the target language




Reading Placement

For ELLs classified as A1, A2 and B1 (if necessary)

Schools with 18 or more K-3 or 22 or more 4™ and 5™
grade ELLs who meet the criteria of A1-A2 in the same
grade must provide sheltered instruction using
identified curriculum and materials

Schools with fewer than 18 or K-3 or fewer than 22 4ih
and 5" grade A1-A2, language classification, ACCESS
1 or 2 in the same grade, must receive basic
mainstream instruction using differentiated instruction
and identified curriculum. Clustering students is
stfrongly recommended.

For ELLs classified as A1, A2 and B1 (if necessary)

Schools with 22 or more ELLs who meet the criteria of
A1-A2 language classification and have level 1 or 2
on the FSA, or no FSA scores, must receive Intensive
Reading through Developmental Language Arts ESOL-
Reading using identified curriculum and materials.

Schools with fewer than 22 ELLs who meet the criteria
of A1-A2, ACCESS 1 or 2 language classification and
have level 1 or 2 on the FSA, or no FSA scores, must
receive Intensive Reading through programs listed in
the K-12 Comprehensive Reading Plan/Intensive
Reading Placement Chart.

For ELLs classified as infermediate 'le Csl 3-6' mci receive basic mainstream instruction

Per META, schools with at least 15 students speaking the same language shall provide at least one aide
or teacher proficient in the same language and trained to assist in ESOL basic subject area instruction.




Factors Influencing Rate of Language Acquisition

« Native Lgngugge Skills e Practice in the Second
« Ed tional Background Language
vedl g * |nstructional

« Background Experiences Environment
 Cognitive Factors * Language

) e Sty Classification
earning Jstyle « Linguistic backgrounds

* Motivation »  Quality of Instruction
Age « Monitoring Patterns
« Accommodations




WIDA Standards exist to promote equity for
ELLs by representing the social, instructional,
and academic language they need to engage
with peers, educators, and school curricula.

~WIDA Focus on Technology in the Classroom, 2014




ESOL Instructional Strategies Matrix
(How We Teach is as Important as What We Teach)

Smategy (VIS)

A B C 1] E F
Accommadations Clear Commumication Assescments Vocabmlary Collaboration & Comversation | Metacopnitive & Afet isth
Al Heritage Dictionary | Bl Concise Language C1 PRubrics D1 Etymology/Cognates Crouping Confignrations: F1 L1 Transfer
A2 Heritage Language | BX Clear Directions C2 Presenfation O] Semantic Feanmre El Hetzrogensous Grouping F2 Mpemonic Devices
(L1} Suppart B3 Emnumnciation C3 Portfolio Analysiz (Languaps'Content Feadiness; F3 Drialogue fournalks
A3 Flexible Scheduling| B4 Pauses & Pacing C4 Checklist D3 Comntext Chiss Leamer Profiles; Interesis) F4 Self-Comection
A4 Flezible Setting B3 Pointng C5 Labeling D4 Tier ITier T Analyzis E?! Homogeneous Grouping F5 Self-Evalation
A5 Flexible Timing Bd PepeatingParaphrazing | Cf Inferview 05 Interactive Word Walks (Languaps'Content Beadiness; Fi Seli-Monditor
BT Gestures C7 Response Cards D6 Vocabulary Games Leamer Profiles; Interests) F7 Peer Edifing
BE Show Examples & CE Cral Assessment 07 Multiple Meanings E3 ligmaw FB Asspciations
Hon-Examples C9  Observation Cf Phonology E4 Peer Pair
BY Demonsratons C10 Context-Embedded | 0P Vocabulary Banks E5 Feader's Theater
B10 Anecdofe Sworyielling Teut Ef Think/FamShare
C11 Votmg Devices E7 Academic Games
C12 Cloze Tex Ef Group Presentations Projects
C13 Visual E? Socratic Seminar
tations E10 Pane] Discussion
C14 Self Peer Ell DebateTefend with Evidence
Aszeszment
C15 Samples
C14 Sentence Frames
[= H I T
Confext Embedded Supports & Close Beading Multimodal & Auoliimedia Advance Organizers Additional Fesonrces
Gl Activating and’or Building Prior 516 Mote- Taking/ Cratline Motes H1 Andio-Visual Appbications| I1 Charts (Flowchars, T-Charts, J1 Art Infepration
Enowledge G117 Cuestion-Answer-Falationship H2 Digital Books eic.) 11 Community Fesourcas
&1 Chunking Text QAR H3 Computer Sofrware I Anricipation Guide I3 Cultoral Sharing
&3 Amnotations & Symboks 18 Readinz with Specific Purpazs H4 Dooment Camera I Comell Motes 14 Celebrations
&4 Ask Inferential & HOT Cuestions G190 Rersad Text H3 Interactive White Board I4 Digital Tools/Sofrare I3 Field Trips
&3 Ask Clarifying (uestions G20 Text Feanmes & Stroctural HS TabletInteractive Devices I5 Foldables J§ Guest Speakers
o Modeling Analysis H7 Lanzuage Master I§ oraphs/Diaprams I7 Holiday Programs
G7 Bead Aloud 521 Survey, Cuestion, Fead, Becite, HE Video/Film/CD/MP3 I E-W-L J2 Muldcubniral Fesoarces
G2 Think Aloud Beview (S03E) H? Digital 5immlations I Reading and Analyzing Non- 19 MusicSongsTazz Chants
&0 Multimodal Texts 522 Tewmt Commections H1{ Translation Devices Fiction (FLAN)
&1 Visnalization Thistrations 123 Total Physical Response (TPR) 19 MWotes T
711 Summarizing 524 Vary Complexity of Assiemment 110 Webbing Mapping
712 Diramatic EnacimenisRaole Play G215 Fealia Manipulatves 111 Stary Maps
513 Identify Key Concepts G216 Captoning I12 Timelines
514 Similarities & Differences 113 Venn Diaprams
715 Langunaze Experience Approach 114 Vocabulary Improvement

Broward County Public Scheols, Bilingual ES0L Deparment
09,2014




PMP Criterio

KINDERGARTEN READING CRITERIA
(Criteria include Measurements at END of each Quarter)

Quarter Criteria #1: OR Criteria #2:
First: Letter Names Assessment
Quarter 1 Benchmark Assessment System (BAS) =< 15/52
Not Applicable OR
Weeks 1-5 PP
Letter Sounds Assessment
First: or = 6/26
Quarte;' 1 Benchmark Assessment System (BAS) OR .
Weeks 6-9 Instructional Reading Level < A @nczp?;f%nt
Letter Names Assessment
< 3B/52
Se a OR
cond:
Quarter 2 Benchmark Assessment System (BAS) OR Letter So:nii; ;zkﬁsscssn:lcnt
Week 18 Instructional Reading Level < B OR
Concepts of Print
< 10/21
Letter Names Assessment
< 46/52
R OR
Quart el: 3 Benchmark Assessment System (BAS) OR Letter Soinii;ffzkﬁssessment
Week 27 Instructional Reading Level < C OR
Concepts of Print
< 14/21
Letter Names Assessment
< 52/52
F OR
ourth:
Quarter 4 Benchmark Assessment System (BAS) OR Letter Soinéi;{;ﬁssessment
Week 36 Instructional Reading ILevel <D OR
Concepts of Print
< 18/21

If performance data indicate the student is working below proficiency in any criteria (1 OR 2), a PMP
should be initiated; intervention instruction provided; and more frequent progress monitoring
administered to target student’s identified needs.

Reading PMP criteria is set at the 9th/final week of each gquarter; however, if student data are obtained
any time prior to the 6th week of each quarter, the District’s 2018-2019 BAS Instructional Reading Level
Chart provides monthly expected proficiency levels to determine the need for a PMP prior to the end of
each quarter.

I _ ELEMENTARY LEARNING DEPARTMENT




Kindergarten PMP Scenarios

Kindergarten Scenarios - Quarter 1 Progress Monitoring Plan (PMP)

Kindergarten Student Scenario #1 — PMP Should Not Be Initiated Until End of Quarter 1

e Kindergarten; Quarter 1, Week 4

o BAS=Level Pre-A; Letter Names=15/52; Letter Sounds=3/26; Concepts of Print=3/21
e PMP should not be initiated in kindergarten until the end of quarter 1. The student is
performin proficiently on level for BAS and Letter Names, however, the student should be
instructed and monitored for progress in Letter Sounds and Concepts of Print to reach
proficient levels for these skills by the end of quarter 1

KINDERGARTEN READING CRITERIA
(Criteria include Measurements at END of each Quarter)
Quarter Criteria #1: OR Criteria #2:
First: Letter Names Assessment
Quarter 1 Benchmark Assessment System (BAS) <15/52
Weeks 1-5 Not Applicable OR
Letter Sounds Assessment
OR <6126
OR
Concepts of Print
<6/21

Kindergarten Student Scenario #2 — PMP Initiated

e Kindergarten; Quarter 1, Week 8

o BAS=Level Pre-A; Letter Names=16/52; Letter Sounds=7/26; Concepts of Print=6/21

e PMP is initiated because although the student is performing proficiently on level for Letter
Names, Letter Sounds, and Concepts of Print, the student is performing below proficiency
on BAS and needs to receive intervention instruction in reading connected text for accuracy

and comprehension

KINDERGARTEN READING CRITERIA
(Criteria include Measurements at END of each Quarter)
Quarter Criteria #1: OR Criteria #2:
Letter Names Assessment
<15/52
OR
Letter Sounds Assessment
First: or <6126
Q,“m 1 | Benchmark Assessment System (BAS) OR
Weeks 6.9 Instructional Reading Level < A C"“‘ipzzf’lf"m‘

Kindergarten Scenarios - Quarter 1 Progress Monitoring Plan (PMP)

Kindergarten Student Scenario #3 — PMP Initiated

Kindergarten; Quarter 1, Week 6

BAS=Level A; Letter Names=15/52; Letter Sounds=6/26; Concepts of Print=1/21
PMP is initiated because although the student is performing proficiently on level for BAS,
Letter Names, and Letter Sounds, the student needs to receive intervention instruction in

reading for Concepts of Print

KINDERGARTEN READING CRITERIA
(Criteria include Measurements at END of each Quarter)

Quarter Criteria #1: OR Criteria #2:

Letter Names Assessment
< 15/52
OR

p— OR Letter Soufcésj;z.ssessment

Quarter1 | Benchmark Assessment System (BAS) OR

Weeks 6-9 Instructional Reading Level < A Concip;s/;]fl’nm

Kindergarten Student Scenario #4 — No Need for PMP

Kindergarten; Quarter 1, Week 7
BAS=Level A; Letter Names=15/52; Letter Sounds=8/26; Concepts of Print=7/21

There is no need to initiate a PMP because the student is performing proficiently on level for
BAS, Letter Names, Letter Sounds, and Concepts of Print

KINDERGARTEN READING CRITERIA
(Criteria include Measurements at END of each Quarter)
Quarter Criteria #1: OR Criteria #2:
Letter Names Assessment
<15/52
OR
OR Letter Sou:n;sfzﬁssessmmt
First:
Quarter1 | Benchmark Assessment System (BAS) OR
Weeks 6-9 Instructional Reading Level < A C"“"ZP? ,Z"{P‘m‘

I _ ELEMENTARY LEARNING DEPARTMENT




What needs to be done before
October FTE?




Funding Sources

WFTE

» Generated by active
ELL students (LYs)

> Part of General Funds
— Program 130

» Managed by the
School Administrator

Title lll, Part A

» Calculated based on
orojections

> Federal Grant

~unding

> M(]ngged by
Bilingual/ESOL




ESOL Compliance for Administrators

2018-2018
August/September October November/December January
Exiting Procedures O  Regiztration, Testing & Placement O Registration, Testing & Placement O Registration, Testing & Placement
(ETS/ACCESS/FSA) Procedures new students {Update Procedures new students (Update Procedures new students (Update
Regiztration, Testing & Placement AD3, A21, A23) AD3, A21 A23) AD3, A21, A23)
Procecures (Update AD3, A21, A23) Annual Reviews™ ([DEUSS Oct. 2016 Annual Reviews* (DEUSS Nov./Dec. Annual Reviews™ (DEUSS Jon. 2017
Updste ELL Folders for LY students and 2017} 2016 oand 2017} ond 2018}
(Azzign Accommeodations, check Re-Evaluations* (DEUSS Oct. 2015 Re-Evaluationz* {DEUSS Nov./Dec. Re-Evaluations* (DEUSS Jon. 2016
schedule, Update ELL PLAN®) and before) Requires ELL Committee 2015 ond before) Requires ELL and before) Reguires ELL Committee
O Annual Reviewsz* {(DEUSS Aug./Sept. Meeting* and L/S/R/W Aszzezzment Committee Meeting* and L/S/R/W Meeting® and L/5/R/W Azzezzment
2016 and 2017) O Update PLAN DATE on A23 Aszeszment O Send dated Notification of
O Re-Evalustions* {DEUSS Aug./Sept O Send dated Notification of O Send dated Notification of Placement/Continuation letter*
2015 and before) Placement/Continustion letter® Placement/Continuation letter* O File ELL Plan/Parent Letter
O Updste PLAN DATE on A23 O File ELL Plan/Parent Letter O File ELLPlan/Parent Letter O Update PLAN DATE on A23
O Senc dsted Notification of O Update ELL Folders and ELL Plans* O Update PLAN DATE on A23 O Update ELL Folders and ELL Plans*
Placement/Continuation letter® O FTE Verification Survey 2 - Run O Update ELL Folders and ELL Planz* O Run ElLevation Reports* to verify
O File ELL Plan/Parent Letter ELLevation Reports* to verify Data O Run ElLevation Reportz* to verify Data Entry
O RunElLevation Reports* to verify Entry Data Entry O Begin planning for ACCESS
Data Entry admin/F54
February March/April May/June
O Registration, Testing & Placement O Registration, Testing & Placement O Registration, Testing & Placement
Procecdures new students (Update Procedures new students {Update Procedures new students (Update
AOD3, A21, A23) AD3, A21, A23) AD3, A21, A23)
Annual Reviews* (DEUSS Feb. 2017 Annual Reviews" (DEUSS March/Apr. Annual Reviews * (DEUSS Moy/June Pleaze refer to the Bilingual/ESOL
ond 2018) 2017 and 2018) 2017 & 2018) webszite for detailed procedures located
Re-Evalustions* [DEUSS Feb. 2015 O Re-Evaluations* (DEUSS March/Apr. Re-Evaluations* {DEUSS Moy/June in the
ond before] Requires ELL Committee 2016 ond beforej Requires ELL 2016 ond before) Reguires ELL ESOL Program Handbook
Meeting® and L/S/R/W Azzezzment Committee Meeting® and L/S/R/W Committee Meeting* & L/S/R/W
O Senc dated Notification of Azzezzment Azzeszment For Support Contact
Placement/Continuation letter® O Send dated Notification of O Senc dated Notification of Bilingual/ESOL Dept.
O File ELL Plan/Parent Letter Placement/Continuation letter* Placement/Continuation letter* 754-321-2530
O Updste PLAN DATE on A23 O File ELL Plan/Parent Letter O  File ELLPlan/Parent Letter
O Updste ELL Folders and ELL Plans* O Update PLAN DATE on A23 O Update PLAN DATE on A23
O FTE Verification Survey 3 - Run O Update ELL Folders and ELL Plans* O Update ELL Folders & ELL Planz*
Ellevation Reportz* to verify Data O  Run ElLevation Repor:z*® to verify O RunElLevation Reportz* to verify
Entry Data Entry Data Entry
O Retention Meetings*
“To be completed on ELLevation

VBS/CC/AP 07/23/13




ESOL at a Glance Detailed Requirements 2018-2019

Identification/Placement ELL Folders/ELL Plans Annual Reviews REEVALS
O Upon registration, parents complete the Initiate an ELL Folder for students who O Based on student’s DEUSS Date (e.g. O Based on student’s DEUSS Date (e.g. August
HLS. If affirmative response to any of the qualify for the program August 2017 and August 2016) for years 2015, 2014, 2013, etc...) for years 4 and beyond
3 questions on the HLS assess students Complete student demographic 2and 3 O Schedule and invite parents to an ELL Committee
O Administer the IPT L/S (Refer to information and one box per year O Conduct Annual Review Meetings* on meeting. Print and file in the ELL Folder.
Placement Chart in Section 2) indicating the required documentation is ELLevation (within 30 days prior to O Conduct 2 meeting® on ELLevation
O Students scoring LES or NES are placed in endclosed anniversary date) (within 30 days prior to anniversary date)
the ESOL Program Complete Programmatic Assessmentand | 0 Generate, print, and sign Student O Use ACCESS and FSA scores to make
O Provide the IMT/IMS the following: test Academic Placement Review (back of Meeting Report* determination of continued placement
scores (A20), LC, DEUSS Date, IM folder) O File a copy of the Student Meeting O Generate and print Student Meeting Report*with
(Immigrant) Status (A03), PLAN Date and Generate ELL Plans® to demonstrate Report in the ELL Folder all present participants’ signatures
TIER (A23) current services (current schedule, O Provide IMT/IMS with updated PLAN O File a copy of the Student Meeting Report in the
[0 After 48 hours, check if data is updated testing accommodations, assessment Date to enter on A23. PLAN DATE is the ELL Folder
on ElLLevation scores, etc.). Save, print and file in the day of the “meeting” O Provide IMT/IMS with updated PLAN Date to
[0 Generate ELL Plan*. Save, print and file ELL Folder O After 48 hours, check if data is updated enter on A23. PLAN DATE is the day of the
in the ELL Folder At the beginning of the year, sign and on ELLevation “meeting”
O Send dated Notification of Placement date ELL Folder. Use checklist on ELL [0 Generate ELL Plan*. Save, printand file | [0 After 48 hours, check if data is updated on
letter* home Folder to ensure all required documents in ELL Folder ElLevation
OO File a copy of the letter in ELL Folder are filed O Send dated Notification of Continuation | [0 Generate ELL Plan*®. Save, print and file in ELL
To order folders, email quantity, contact of Services*letter home Folder
name, and school name to: O File a copy of the letter in the ELL O Send dated Notification of Continuation of
esolrequests@browardschools.com Folder Services*
O File a copy of the letter in the ELL Folder
Sections 1 & 2 of ESOL Handbook
Section 7 of ESOL Handbook Section 7 of ESOL Handbook
Section 3 of ESOL Handbook
Accommodations Exit Post Exit Monitoring ElLLevation
O Assign on ELLevation: Student List-> If student met State criteria, ETS will O Monitor LF students for 2 years O Use Student List to identify ELLs on 2 monthly
Active LY Students->Assign->Edit->Assign automate the exit process on TERMS O Monitoring is completed at four basis (Student List ->Views -> Shared With Me -
Accommodations*® (PLAN & EXIT Date, Basis of EXIT, TIER, specified times based on the exit date >Reports -> Active LY Students-> Export to CSV)*
O Provided to LYs on a regular basis (for LEP Status, and Program Code) O LFMonitoring Year 1: 1% report card, O Use Data Dashboard to identify languages
teacher-created tests, chapter tests, as If student is exited via ELL Committee, End of 1= semester, and End of 1** year represented by number of LYs and LFs (Student
well as statewide assessments) conduct a Meeting on ELLevation* O LFMonitoring Year 2: End of 2™ year List ->Shared View “Composite”)*
O Documented on teachers' lesson plans O Conduct a Post-Exit Monitoring O Generate required letter: Student List -> Select
O State approved accommodations are: After Student Has Exited: Meeting* all students from Saved View of LY->Reports-
Flexible Scheduling, Assistance in the Generate Parent Notification of EXIT* O Gather information from classroom >Select Parent Letter-> Adjust Parent Letter
Heritage Language, Approved Dictionary letter and file in ELL Folder teacher (grades, progress, etc.) Options->Generate Letter->Print*
and/or Glossary, Flexible Setting O File current report card along with a O Generate ELL Plan: Student List->Select all or

O Flexible setting requires a dated parent
notification letter to be sent home and a
copy filed in ELL folder

[0 Generate, save, print, and file ELL Plan*
with updated accommodations in ELL
Folder

Section 5 of ESOL Handbook

After 48 hours, check if data is updated
on ELLevation

Generate ELL Plan®. Save, print and file
in ELL Folder

Section 6 of ESOL Handbook

signed and dated Student Meeting
Report

Section 6 of ESOL Handbook

individual students from Saved View-> Reports -
>ELL Plan-> Save->Print*

Section 12 of ESOL Handbook

CC/VBS/SB/AP 09/20/2018







Annual Review REEVALS
For students entering a US school in 2016-2017 or 2017-2018 For students entering a US school in 2015-2016 or earlier

v' Recommendations for confinued placement for v Recommendations for ELLs entering years 4,

ELLs entering years 2 and 3 based on DEUSS 5, 6 and beyond based on DEUSS (within 30
(within 30 days) days)

v ELL Committee IS required.
v Current data must be reviewed to make
recommendation for continuation of

NN

ELL Committee Meeting is not required services. After Oct. 15 IPT assessment

Complete Me, Myself & | Meeting on ELLevation (L/S/R/W) must be administered; however,

Print meeting report, sign, and date do not update language classification if
they have ACCESS scores.

v' Print ELL committee meeting report at time
of meeting. Have all members (and
parent) sign meeting report and date.

v Update PLAN Date and REEVAL date on
TERMS (date of ELL Committee Meeting

v' Generate Parent Letter with letter mailing date
(Notification of Confinuation)

v' Update ELL PLAN Date on TERMS and PLAN date shall match.)
v Generate Dated Parent Letter (Notification
v" Ensure Testing Accommodations are updated for of Continuation) and file in ELL folder
current school year . v Ensure Testing Accommodations are
v Generate and save the ELL Plan within the updated for current
required 30 day timeline and file in ELL Folder 7 Censraie and seve The BUL Plarm withi The

required 30 day timeline and file in ELL
Folder

ANNUAL REVIEWS VS REEVALS (Extension of Service_




Functions of the ELL Committee

. NIEW
Function Members
« Resolve any issues Minimum of{3School Personnel
affecting instructional « Administrator or designee

« ESOL teacher

« Home language teacher (if
applicable)

« Classroom/subject area teacher(s)

« School counselors, school social
workers, school psychologists

« Other educators as appropriate

decisions of an ELL

« May make program
placement
recommendations

* Meeting must be
performed on « Parents must always be invited to attend

(and added as an “other” attendee in ELLevation)

*Signatures in blue or black ink are required for all participants including administrators.
Parent(s) and/or guardians are always invited, however, if they do not attend, the
meeting still takes place. The outcome of the meeting is made available to parents in
writing via the Parent Notification Letter in their native language and filed in the ELL Folder







2018-2019 ACCESS for ELLs 2.0

Testing Window for 2018- 2019:

1/28/19-3/21/19

https://wida.wisc.edu/ e
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Intfro to Wida PD

» Rock Island Professional Development Center (RIPDC)
Room 401

= K-5 Tuesday, November 271 (8:00 a.m. - 3:00 p.m.)
= 6-12 Thursday, November 291 (8:00 a.m. — 3:00 p.m.)

IPT Refresher

e September 24, 2018, RIPDC
e8a.m.-11Ta.m. OR
*12p.m. -3 p.m.

e Park Lakes October 19, 2018
e8a.m.—-11 a.m.

= Register on My Learning Plan _




Title lll Initfiatives

Title Ill, Part A Grant funds to
implement the 2018-2019 Language
Enrichment Camp (LEC) for English
Language Learners (ELLs) will be
available.

Saemone
Hollingsworth

“ Estella Eckhart
m Mark Narkier

Title 1l additional funding for “ Linda Pazos

Supplemental Instructional EXE3 Dr. Mark Strauss
Materials in the core content areas to I3 Emie Lozano

assist ELLs (LYs) with academic SR Angsla Fulton

achievement, English language Teoa o

acquisition or native language support. Haywood
EE2 sandra Shipman

Support to schools through the
Bilingual/ESOL Department
Instructional Facilitators.

w Dr. David Hall

m Christine Semisch
Dr. Jermaine
Fleming

Immigrant Grant activities (i.e., field  TSEE Michael Ramirez
trips, Rally to the Tally, Broward Youth [EEFEM Alan Strauss

Summit, CANA) Cs1 sDk:a iorlefho

TITLE III/IMMIGRANT SUPPLEMENTAL SERVICES

Cadre | Cadre Director ESOL Instructional
Facilitator

Dual Language
Instructional
Facilitator

Jessica De La Prida  Sonia P.

Deborah Benitez-
Rosa
Miriom Acevedo

Miriom Acevedo

Jennifer Desmidt
Jennifer Desmidt
Armelle Johnson

Cristal
Concepcion
Adalyn Pena
Cristal
Concepcion
Deborah Benitez-
Rosa

Annefte Ramos

Rodriguez

Sonia P.
Rodriguez
Gloria Rodriguez

Sonia P.
Rodriguez
Gloria Rodriguez
Gloria Rodriguez
Sonia P.
Rodriguez
Sonia P.
Rodriguez
Gloria Rodriguez
Gloria Rodriguez

Sonia P.
Rodriguez
Gloria Rodriguez

Rosemarie Richard N/A

Eric Rosenauer
Annefte Ramos

N/A
N/A




Skype for Business

(S) Skype for Business

Skype will replace Adobe Connect Sessions to deliver quarterly
ESOL Contact Meetings and Touch Base Tuesday meetings.




BILINGUAL

B EF A BT M E H

A

ESOL PARENT LEADERSHIP COUNCIL MEETING

Reunidn de Consejo de Padres ESOL
Reyvinyon Konséy Egzeldaf ESOL
Reuniio do Conselho de Pais do ESOL

“EVERYTHING YOU NEED TO KNOW ABOUT THE ESOL PROGEANM™

Todo lo gue usted debe saber sobre el programa ESOL
Tout bagay ke ou bezwen konnen de program ESOL
Tudo o gue vocé precisa saber sobre o programa ESOL

Thursday, September 20, 2018
Jueves, 20 de septiembre, 2015
Jedi, 20 septanm, 2018
Quinta-feira, 20 de setembro de 2018

SYW Regional Library
165835 Sheridan 5t. Pembroke Pines 33331
10:00 am — 12:00 pm

OR

*Thursday., October 4, 2018
Jueves, 4 de octubre, 2018
Jedi, 4 Oktob, 2018 [re———
Ouinta-feira, 4 de ontubro de 2018 1’,"-“'litms for l—Sq‘.I-L ‘v| Py
0;‘;{:213;;: #ill be g on © |
Indian Ridge Middle School | ¥ou ae imc;_ﬁ”“““?.iuin us if |
1255 Nob Hill Ed. Davie 33324 o sted iy Serving
6:30 pm — 8:30 pm I

Information Informsacieom Enfomasvom Informacio
TE4-211-205]
Email: esolparents@ browardschools com

cia Good - Dorra P Kom

Lawsrie Rich Lewirmon = &nn Morray = Or. Aceaind Osgoed = Hora Rupert = Robert W Funcie, Superintendant of Schools
F nfeeratior. warksd S,
wemrr
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Eptan! 15y contad Bu (e o e Bl Esucrion UAES AL G s
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Youth Policy Summit

<>
CLOSEAUP 7 BROWARD
L\(IV( (/u ‘-Z\ah

L(ue ( {p % omlda(mn & Bx(m(ua(x LQO«L
,-D({*ar(mmt mnlm((t/ invite - you to the:

CLOSE UP . BROWARD YOUTH POLICY SUMMIT EXPO
DATE: NOVEMBER 16, 2018
LOCATION: NOVA SOUTHEASTERN UNIVERSITY
TIME: 10:00 AM - 12:00 PM WITH LUNCH
IMMEDIATELY FOLLOWING EXPO

These hundeed immigroat high schoed stedeats bom throsgheat Brownrd Counsy will
be eahsbiting and presenting thewr Horido Legishative Policy Propesels and shese theis
ideas ca how to improve thee commanities.

Pleasa join us to honor these studeats who howe worked so hosd to develop o yuth
agenda for Flosde policy ectien. This event is o follow up to our 2077-18 Gese Up —
Eolly %o the Tolly whess sdenss preserted Sheir legisiotve agendas o stom elected
offioaks in Tallshessee. We book foowasd % sesing you. Mark your colendars!

Pleese register of hgs.//bit /2054FVN

For moes infeemotien coatoct, Vicky Solale, ESOL Dissctor,
ot vichorio seidela (@ browordschoals.com or $54-552-6474.

CLOSEaUP N “w BROW,

Lgtll)t’ (/u‘ ez\d(('

Sc‘ Z qn 7o mudalmn & Bllm{uat/LSC)

CLOSE UP - BROWARD PARENTS IN ACTION SUMMIT
DATE: NOVEMBER 17, 2018
LOCATION: SIGNATURE GRAND

TIME: 9:00 AM - 2:00 PM WATH LUNCH
IMMEDIATELY FOLLOWING EXPO

Srowerd Couny Publc Scheels Sdiagea/ES0L Depertrment, in potenbiy with the Ooe %
Foundetion, iovide you 9 dske adwantege of 0 mz secvaner foe bigh schol stodests ood peseets of
3PS Eaglah losguege loervens o mmigrost studenss The eveet avl prowde mnpertent indenaton
obost edult edecstion progreens fee parents eod college op s for stodests. Addiseenth
pasests can ko abeet e owx engogement progrems (kne Up bas prwided sxevigoant m&m
througheet the onty.

Pheese joee us 99 hosat ond support these Browond County sudents sed fanndies ood keem bow we 2n
enceerege our dudenty by echieve thew percnd ond edueationsl gask. We losk harmard to seaing
o Mark yeer cakedon!

Please register o itigs:/roeer dporeatiioscion eventivite com

For move isdarmation comtoct, Wicky Sabdaka, ESOL Direcr,
ot vickes. seldele @ beomardachools com o §54- 552 8474




Dear Florida Educators,

We are writing to share information about the 2018 Hispanic Heritage Month student art and essay
contests and educator awards. Through this contest, three Florida students will earn a 4-YEAR FLORIDA
PREPAID SCHOLARSHIP.

Once again, Governor Rick Scott and First Lady Ann Scott have invited all Florida students to participate in
the annual Hispanic Heritage Month art and essay contests, which will be centered around the theme, “A
Celebration of Innovative Hispanic-American Leaders.” Students in grades K-3 have a chance to win a
cash prize by submitting artwork, and students in grades 4-12 can earn a 4-YEAR FLORIDA PREPAID
SCHOLARSHIP through the essay contest.

The prizes could transform the lives of a student in your class or school. We hope that you will encourage
all of your students to take full advantage of this opportunity to enhance their appreciation for Hispanic-
American History and prepare financially for their own future education aspirations.

Additionally, students, parents, teachers and principals are invited to nominate full-time educators in
elementary, middle and high schools for the Hispanic Heritage Month Excellence in Education Award.

All entries must be received no later than 5:00 p.m. Eastern Time on Monday, October 15, 2018.

To learn more about Florida's Hispanic Heritage Month celebration and contests,
visit www.FloridaHispanicHeritage.com. You can also access promotional materials to share with your

students and their families at hitp://www.fldoe.org/newsroom/hhm.stmi.



https://na01.safelinks.protection.outlook.com/?url=http://www.FloridaHispanicHeritage.com&data=01|01|victoria.saldala@browardschools.com|0002a4ecbadc4e1f464808d61cdeb5ec|eeacb5cb53704358a96aa3783c95d422|1&sdata=GcGp2/FPklhWOmRvUSWZItpIgBWHOyHYVbunH7LJVqQ%3D&reserved=0
https://na01.safelinks.protection.outlook.com/?url=http://www.fldoe.org/newsroom/hhm.stml&data=01|01|victoria.saldala@browardschools.com|0002a4ecbadc4e1f464808d61cdeb5ec|eeacb5cb53704358a96aa3783c95d422|1&sdata=1FCS%2Brh98FaLdmmN89q6IP5/1oLd/ExE50O2vYu%2BVjE%3D&reserved=0

for stucents

y YOUR CHILD
Jogp 1P I’lﬁ VING TMUBI.E READING?

Reading Scholarship Accouht; |

In 2018, Florida became the first state to offer an education savings account program for students enrolled in
public schools. The Reading Scholarship, administered by Step Up For Students, was created to help public
school students in third through fifth grade who struggle with reading. The program offers parents access to
education savings accounts, worth $500 each, to pay for tuition and fees related to part-time tutoring, summer
and after-school literacy programs, instructional materials and curriculum related to reading or literacy.

Who Is Eligible?

« Third- through fifth-grade public school students who scored a 1 or 2 on the third or fourth grade

English Language Arts section of the Florida Standards Assessment in the prior year.

« Students who are classified as English Language Learners, and who are enrolled in a program or
receiving services that are spedfically designed to meet the instructional needs of English Language
Learner students, will receive priority.

What Is It?

« The scholarships are worth $500 each and can be used for reimbursement for the following:

» Tuition and fees for part-time tutoring provided by a person who holds a valid Florida educator’s
certificate, a baccalaureate or graduate degree in the subject, an adjunct teaching certificate, or has
demonstrated mastery of the subject area knowledge.

» Fees for summer education programs designed to improve reading or literacy skills.

» Fees for after-school education programs designed to improve reading or literacy skills.

» Instructional materials and curriculum related to reading or literacy.

« Program funds are limited and are available on a first-come, first-served basis.

How Do I Apply?

Visit StepUpForStudents.org for the latest information

Reading Scholarship Questions? 2
5 reading@sufs.org 4, Scholarship Hotline 877-735-7837 |

THE SCHOOL BOARD OF BROWARD COUNTY, FLORIDA
€00 8 E 3 Avenue, Fort Lauderdaie. FL 33301 « Office: 754.321.2618 « Fax 754.321.2701

Office of Academics "-35'"""-“"
Daniel Gohl, Chief Academic Officer S —y
754.321-2618 Mo fpas, Chr
dm!‘ t 8. b |’.m Hastwe P Borkaceft Vou Ohver
wax Bartorias
Aty W Froedner
Parem Gond
LA~

September 4, 2018

Dear Parent or Guardian,

TheSmeobetidahascru!edanmvscholarshipforsmdmtsmhmscomdalevel1or2

on the Grade 3 or Grade 4 Florida Standards A English Language Arts (FSA-ELA).
The Reading Scholarship, admmeredbyShepUpForSmdmu wasueaud\ohdps(udens
in third through fifth grade who struggle with The b a family for

wwﬁoomlonumonandfeesmlatedtopan-ammnm summerandanerschool
lum related to reading or literacy. These scholarships
vnllbenudeavahbleonaﬁmeome first serve basis.

Students who have scored 3 level 1 or 2 on the Grade 3 or Grade 4 FSA-ELA in the prior year
are efigible to apply. Students who are classified as English Language L and are lied
in a Flonida program, or receiving senices that are specifi designed to meet the i ional

needs of English Language Leamer students, will receive pnouy

The application and more information can be found at:

hitps://wvav_stepupforstudents org/for-parents/reading-scholarship'how-the-scholarship-works/
or on the enclosed attachment. An interactive Online Chat assistant is available on the website to
provide real-ime answers to any questions.

Broward County Public Schools (BCPS) 15 committed to working with you at every grade level,
and throughout the year, to improve your chid's reading and iteracy level. Information on the
BCPS approach to literacy and strategies to support reading at home can be found at the links
below:

+ BCPS Literacy Field Guide: hitp://www bops-literacyguide com/

» BCPS Read-At-Home Plan: hitps./igoo gUJG1RAH

We look forward to another successful school year!

Sincerely,
Daniel Gohl
(I:hiefAcadenic Officer




Bilingual/ESOL Parent Outreach
Office
/54-321-2951

Inform parents and families about
American and Broward County
School systems

Provide assistance with ELLs and
school-related issues

Provide graduation, college, and
career orientation for students and
parents of middle and high school

Created to assist non-English speaking families,
especially newly arrived, with the transition to
BCPS

Help families to be connected, comfortable and
confident with education their children receive




Bilingual ESOL Share Point

QuickLinks Bilingual/ESOL

Bilingual/ESOL Intranet Home

ESOL Program

~ ESOL Memos.
* ACCESS for ELLs 2.0
Dual Language

Interpretation / Translation
Services

World Languages
Bilingual Parent Outreach

Site contents

a\\
QuickLinks ESOL Contact Info

Bilingual/ESOL Intranet Home
ESOL Program

ESOL Contact Info
. &=
. AN

& ESOL Program Overview SharePoint.pdf

* ACCESS for ELLs 2.0
Dual Language

Interpretation / Translation
Services

World Languages
guags v [} Name Modified  Modified By

Bilingual Parent Outreach

ACCESS for ELLs 2.0 (WIDA) -+ May 2 Rosemarie Richard
Site contents
District ELL Plan =+ May 1 Rosemarie Richard
ESOL Program Forms =+ May 1 Rosemarie Richard
ESOL Program Handbook =+ May 1 Rosemarie Richard
[ K-12 ESOL Program BCPS -+ May 2 Rosemarie Richard

h’r’rps://browordcoun’ryschools.shorepoin’r.c-:-om/
Wy s/Home.aspx
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Bilingual ESOL Leadership

Vicky B. Saldala, Director

Leyda Sotolongo, ESOL Curriculum Supervisor
Stephanie Bustillo, Educational Specialist
Melinda Mayers, Educational Specialist

TBA, Parent Outreach Specialist
Blanca Guerra, Curriculum Supervisor, World Language Supervisor

Idalina Orta, Dual Language Specialist

Reina Murray, Bilingual Guidance Counselor

Celina Chavez, Educational Specialist, Charter School Support

7/54-321-2590 KCW
7/54-321-2951 Pembroke Pines
http://bilingual-esol.browardschools.com
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